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 ABSTRACT

This technical report contains a collection of hints and tips for VisualAge TeamConnection
Enterprise Server Version 3 users and family administrators that must cope with the heteroge-
neous operating systems environments supported by VisualAge TeamConnection.

This document focuses on several system-related tasks that are different across the diverse
platforms available to developers using VisualAge TeamConnection. Some sample tasks are:

� How to configure the system files related to TeamConnection.
� How to shutdown and reboot a workstation.
� How to create a user ID.
� How to query for the free space of a file system.
� How to test the connectivity of the host.
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 INTRODUCTION

This technical report contains a collection of hints and tips for VisualAge TeamConnection
Enterprise Server Version 3 users and family administrators that must cope with the heteroge-
neous operating systems environments supported by VisualAge TeamConnection.

This document focuses on several system-related tasks that are different across the diverse
platforms supported by VisualAge TeamConnection:

1. Some tasks that are usually performed by end users (which also include system and
family administrators) are described in “End User Tasks” on page 5.

2. Some tasks that are usually performed to test the connectivity of the TeamConnection
client machine and the TeamConnection family server machine are described in
“Connectivity Tasks” on page 23.

3. Some tasks that are usually performed by system and family administrators are described
in “Administrative Tasks” on page 29.

Each task is grouped, where appropriate, into "Unix" (that is, AIX, HP-UX and Solaris) and
"Intel" (that is, OS/2, Windows NT, and Windows 95) sections, since there are typically signif-
icant differences in how tasks are performed for each group.

There are subsections where differences exist between specific operating systems in a group.
For example, the administrative tool in AIX is smit, in HP-UX is sam and in Solaris is
admintool.
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RELATED TECHNICAL REPORTS

The following technical reports provide more details on installation and maintenance tasks for
DB2 Universal Database V5 which is the database management system used by VisualAge
TeamConnection Enterprise Server Version 3:

 � TR 29.3076

Configuration and Administration of DB2 Universal Database V5 by users of VisualAge
TeamConnection Enterprise Server V3.

VisualAge TeamConnection Enterprise Server Version 3 uses DB2 Universal Database V5
(DB2 UDB V5) to store objects and parts. This technical report provides a collection of
hints and tips for the installation and configuration of DB2 UDB V5 for the supported plat-
forms.

This technical report is based on the technical report TR 29.2267 for Version 2:
"TeamConnection frequently asked questions: how to do routine operating system tasks".

How to get the most up to date version of this technical report.

This document, as well as other recently released technical reports related to
TeamConnection, contains some information that was previously available in other "unofficial"
documents. We have endeavored to better organize the information and improve its read-
ability so that you will find it more useful.

The most up to date version of this technical report can be obtained from the IBM VisualAge
TeamConnection Enterprise Server:

� Library home page by selecting the item Library at URL:

http://www.software.ibm.com/ad/teamcon

� FTP site by accessing the URL:

ftp://ftp.software.ibm.com/ps/products/teamconnection/papers

See the file README.index.txt for details.

 SUPPORTED PLATFORMS

The supported operating systems for VisualAge TeamConnection Version 3 that have both
server and client code are:

AIX Version 4.2.1
HP-UX Version 10.20
Solaris Version 2.5.1
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OS/2 Warp Version 4
Windows NT Version 4

The operating systems that have only client code are:

 Windows 95

Note:  Notice that the client for Windows 3.1, which was supported in VisualAge
TeamConnection version 2, is no longer supported in Version 3.

NOTES ON THE TERMINOLOGY USED IN THIS DOCUMENT

� Some tasks are specific to the Unix family of operating systems, due to the multi-user
characteristics.

� The names of the operating systems will be used without the version numbers, when there
is no need to specify it. For example, the term "AIX" means in this document "AIX Version
4".

� The term Unix will be used as a generic term for all the different Unix versions when there
is no need to specify one of them.

� The term Windows will be used as a generic term for all the different Windows versions
when there is no need to specify one of them.

� The term Intel will be used as a generic term for the non-Unix operating systems that run
under Intel processors (OS/2 and Windows) when there is no need to specify one of them.

NOTES FOR INTEL USERS

Installing Unix-like commands

We strongly recommend installing a package of Unix-like commands for your Intel platform
(such as grep, which, cut).

These packages are generally inexpensive and provide between 30 and 100 useful tools that
are common to Unix operating systems. These tools will allow you to perform most of the
Unix commands described in this document on your Intel operating system.

You may try to find such packages from the Internet by using search engines such as
"http://www.yahoo.com/" and using keywords such as "OS/2 utilities" or "Windows NT utilities".
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One family per Intel host

Due to the performance characteristics of Intel machines, it is strongly recommended that only
one DB2 instance and only one TeamConnection family should be installed in an Intel host.

Furthermore, the Windows NT "Administrator" user id cannot be used to administer the DB2
instance and to handle the DB2 tools. This user id does not comply the upper limit of 8 char-
acters in the user id. Thus, another administrator user such as "db2admin" must be created
to handle the DB2 activities. This in turn, has an effect in the maintenance of a
TeamConnection family, which uses the DB2 facility. In other words, if you use "db2admin" to
start DB2, then it is better to use it also to start the TeamConnection family.
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END USER TASKS

This section describes some common tasks and useful information for TeamConnection client
users.

WHAT IS THE DIRECTORY STRUCTURE FOR TEAMCONNECTION?

This section provides a summary of the default directory structure used by VisualAge
TeamConnection:

� DB2 UDB - code

The UNIX location cannot be changed!

AIX /usr/lpp/db2_05_00
HP-UX /opt/IBMdb2/V5.0
Solaris  /opt/IBMdb2/V5.0
Windows NT  c:\sqllib
OS/2 Warp c:\sqllib

� DB2 instance (such as db2inst1)

The UNIX location cannot be changed if you use the DB2 installer!

AIX /home/db2inst1
HP-UX /home/db2inst1
Solaris  /export/home/db2inst1
Windows NT  c:\sqllib
OS/2 Warp c:\sqllib

� DB2 Administration Server (such as db2as)

The UNIX location cannot be changed if you use the DB2 installer!

AIX /home/db2as
HP-UX /home/db2as
Solaris  /export/home/db2as
Windows NT  c:\sqllib
OS/2 Warp c:\sqllib

� VisualAge TeamConnection code

AIX /usr/teamc
HP-UX /opt/teamc
Solaris  /opt/teamc
Windows 95 and NT  c:\teamc
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OS/2 Warp c:\teamc

� VisualAge TeamConnection family (such as tcfamily)

AIX /home/tcfamily
HP-UX /home/tcfamily
Solaris  /export/home/tcfamily
Windows NT  c:\tcfamily
OS/2 Warp c:\tcfamily

By default, the actual database is stored under the DB2 Instance home.

HOW TO FIND TEXT STRINGS (GREP AND FIND COMMANDS)

 Unix: grep

The "grep" utility can be used to find out strings inside files or as part of a redirected output
from a line command.

� Example of searching for the strings that contain "DB2" in the .profile for a family:

grep DB2 .profile

The output could be something like this:

export DB2INSTANCE=db2inst1

export DB2DBDFT=$LOGNAME

� Example of searching for the environment variables that contain "DB2":

set | grep DB2

The output could be something like this:

DB2INSTANCE=db2inst1

DB2DBDFT=$LOGNAME

� Example of searching for the strings that contain "DB2" or "db2" (case insensitive) in the
/etc/services file:

grep -i db2 /etc/services

The output could be something like this:

db2cd2inst1 5ðððð/tcp # Connection port for DB2 instance db2inst1

db2id2inst1 5ððð1/tcp # Interrupt port for DB2 instance db2inst1
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 Windows: findstr

The equivalent command in Windows for the "grep" command in Unix, is "findstr".

 Unix: find

The "find" utility can be used to find files that satisfy certain criteria. Even though it is a very
powerful command, it is a bit difficult to understand and master, therefore, this section shows
2 actual Korn shell scripts that exploit this command.

Finding file names in subdirectories

To see if a file named "file.c" is located inside a directory structure, and to find out where is
actually located, issue the following command:

$ findfile . file1.c

findfile: searching in . for file1.c

./src/file1.c

In this example, the directory structure is the current directory and the file was found in the
subdirectory ./src

The findfile Korn shell script is shown below:
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#!/usr/bin/ksh

#---------------------------------------------------------------------+

# NAME: findfile path filename

#

# DESCRIPTION:

# This shell script is a global find file command.

# This shell script invokes the find command to perform a recursive

# search in the directories.

#

#---------------------------------------------------------------------+

#

# Invoke findfile

USAGE="findfile path filename"

if ⅛ "$#" -eq 2 ‘

then

echo "findfile: searching in $1 for $2"

find $1 -name $2 -print

else

echo "findfile: Usage is = $USAGE"

echo " example from current directory: findfile . filename "

echo " example from home directory: findfile $HOME filename "

fi

# end of file

Figure 1. findfile: Korn shell script to perform a global find for files

Finding a string in a set of subdirectories

To find the files inside a directory structure that have a particular text string (such as
msgText), issue the following command:

$ seek msgText

seek: searching for msgText

find . -type f -exec grep -l 'msgText' {} \;

./src/file1.c

In this example, the directory structure is the current directory and the file was found in the
subdirectory ./src

The seek Korn shell script is shown below:
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#!/usr/bin/ksh

#---------------------------------------------------------------------+

# NAME: seek string

#

# DESCRIPTION:

# This shell script is a global find string command.

#

# This shell script invokes the find command to perform a recursive

# search in the directories. The find command uses

# the grep command to search for the actual string.

#

#---------------------------------------------------------------------+

#

# Invoke seek

USAGE="seek string"

if ⅛ "$#" -eq 1 ‘

then

echo "seek: searching for $1"

echo "find . -type f -exec grep -l '$1' {} \;"

find . -type f -exec grep -l "$1" {} \;

else

echo "seek: Usage is = $USAGE"

fi

# end of file

Figure 2. seek: Korn shell script to perform a global find for strings

HOW TO FIND OUT THE VERSION OF TEAMCONNECTION?

GUI - all platforms

The version of the TeamConnection GUI for all platforms can be found from the Help
pulldown, option "Product Information". For example:

IBM VisualAge TeamConnection for Windows, Version 3 Release ð Mod 1

It is important to clarify that due to the GUI -> line command -> server model of
TeamConnection, the version of the GUI might be different than the line commands or the
server. This could happen if there are hotfixes applied to one of them.
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Unix - Client/Server

The version of the TeamConnection server and line commands for Unix can be found as
follows:

1. Find out the directory where the daemon (teamcd) or the client (teamc) is installed:

� For AIX or Solaris, enter:

which teamcd

� For HP-UX, enter:

whence teamcd

2. Change to the directory shown in the step above.

3. Use the 'what' command to find out the embedded strings that begin with @(#) and search
for the 'teamc' keyword:

� For the server, do the following:

what teamcd | grep teamc

The output should look like this:

teamcd:

teamc (C) Copyright IBM Corp.,1996,1998

teamc Platform: AIX tcaixð2 1 4 ðððð44289ððð

teamc Release: v31ð

teamc Driver: N98-1ð-17

teamc The database is DB2 Universal Database Version 5.ð.ð

Figure 3. Output of 'what teamcd' that shows details about AIX teamcd

� For the client, do the following:

what teamc | grep teamc

The output should look like this:

teamcd:

teamc (C) Copyright IBM Corp.,1996,1998

teamc Platform: AIX tcaixð2 1 4 ðððð44289ððð

teamc Release: v31ð

teamc Driver: N98-1ð-17

Figure 4. Output of 'what teamc' that shows details about teamc
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Notice that the output for the client is the same as the server, with the exception of the
line about the database name and version.

4. You can use the following statement to perform in a single statement the operations of
finding out where the file is located and then doing the what command against that file:

 � Option 1:

what 'whence cmvcd' | grep cmvc

Note:  Where ' is the accent grave, in the upper left corner in the English keyboard.

� Option 2 (only when using Korn shell):

what $(whence cmvcd) | grep cmvc

Note:  The release string "v310" in the output from the "what" command represents Version 3
Release 0 Modification 1 (or Fixpak 1) of VisualAge TeamConnection.

Intel - Client/Server

The client and code for Intel has the same "what" strings and if you have access to a similar
"what" and "grep". command, then you can find out the version of the TeamConnection exe-
cutables.

For OS/2 and Windows NT, TeamConnection provides a version of the "what" command:
tcwhat.

� Locate the TeamConnection "bin" directory on the path:

echo %PATH%

or

PATH

� Change to the appropriate directory for VisualAge TeamConnection that is shown in the
PATH, such as C:\TeamC

� Use the 'tcwhat' command to find out the embedded strings that begin with @(#):

tcwhat teamcd

The output should look like this:
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teamcd:

teamc (C) Copyright IBM Corp.,1996,1998

teamc Platform: Windows NT Version 4.ð

teamc Release: v31ð

teamc Driver: N98-1ð-17

teamc The database is DB2 Universal Database Version 5.ð.ð

Figure 5. Output of 'what teamcd' that shows details about Windows teamcd

HOW TO FIND OUT THE VERSION OF THE OPERATING SYSTEM?

Unix - operating system version

You can use the command "uname -a".

The output will be similar to the following:

 � AIX

AIX oem-ppc3 2 4 ðððð22559ððð

 = +

= ++++++ Version

 =

 ============ Release

Notice that the version (4) is shown after the release (2). Thus in the above example, the
operating system is: AIX 4.2

 � HP-UX

HP-UX oem-hp1ð B.1ð.2ð A 9ððð/77ð 2ðð6ð68783 two-user license

 +++++

 +

++++++ Version + Release

In the above example, the operating system is: HP-UX 10.20

 � Solaris

SunOS oem-snð8 5.5.1 Generic_1ð364ð-14 sun4u sparc SUNW,Ultra-2

+++++ +++++

 + +

+ ++++++ Version + Release + Level

 +

+++++ "Generic" term for the family of SunOS operating systems.

In the above example, the operating system is: Solaris 2.5.1. The explanation for the
equivalence between "SunOS 5.5.1" and "Solaris 2.5.1" is shown below.
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The SunOS operating system (Version 4.x) was based on the BSD Unix system.
However, due to the industry convergence to the System V Unix system, the Solaris 2.x
operating system was born, which is not binary compatible in most cases with the SunOS
operating system.

However, for marketing reasons (and not for technical reasons), a family of operating
systems was created, in which the term "SunOS 4" refers to the old SunOS, and the term
"SunOS 5" refers to the new Solaris system (but the Solaris version number begins with
2). One example of this strategy is in the output of the "uname" command, in which
"SunOS 5.5.1" really means "Solaris 2.5.1".

This is used to cause a lot of confusion a couple of years ago, when the customer base
for SunOS was larger than the Solaris one. Specifically, due to the binary incompatibility
between SunOS 4 and Solaris, in CMVC we provide two versions, one for the old SunOS
4 and another one for the new Solaris; when a customer said, I have a Sun operating
system, we had to ask, which one?

AIX level version

For AIX, you can find the level (that is, version.release.level) using the following command:

oslevel

The output looks like this:

4.2.1.ð

This is more conclusive than looking at the different "bos.*" installp packages in your system
and trying to guess which one represents the actual level number.

X-Windows server version

The X-Windows server is the program the manages the graphical display on your system and
communicates with the TeamConnection GUI for Unix. The X-Windows server needs to be
running when you run the following command:

xrdb -symbols

The output will have a lot of entries, the ones that are of interest are the ones that identify X11
R5 as follows:

-DVERSION=11 -DRELEASE=5
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Intel - operating system version

You can use the command "ver". For example:

Windows NT Version 4.ð

 Windows

1. Select Start -> Settings -> Control Panel.

2. Double click on the icon System.

3. In the tab "General" you will see the version of the operating system, such as:

Microsoft Windows NT

4.ðð.1381

 MISCELLANEOUS VERSIONS

Because HP-UX has a history of significant bugs in certain versions of tools, it is important to
know what version you have:

� Check for version of compiler: what cc

Look for something like "A.10.13"

� Check for version of linker: what ld

Look for something like "B.10.19"

WHERE ARE THE CUSTOMIZATION FILES FOR THE
TEAMCONNECTION GUI?

Unix - Customization files

There are two customization files for the GUI:

 � $HOME/teamcv3x.ini

This is the file that contains the tasks shown in the TeamConnection GUI Tasks window
and contains values used by functions in the GUI.

The user could copy the sample task list and customize it by using the GUI and not by
modifying directly this file (in Unix):

cp /usr/teamc/nls/cfg/$LANG/teamcv3x.ini $HOME/.

chmod u+w $HOME/teamcv3x.ini
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Note:  It is strongly recommended that the users should not attempt to edit this file; use
the GUI functions from File -> Task List -> Edit task list.

 � $HOME/Teamcgui

This is the local Motif Resource File in Unix where the user can specify the font type and
size, and colors.

If this file does not exist, then the GUI will NOT create it in the $HOME directory; instead,
the GUI will rely on the system-wide Teamcgui resource file which is located in
/usr/teamc/nls/msg/$LANG/Teamcgui.

The user could copy the sample and customize it (in Unix):

cp /usr/teamc/nls/cfg/$LANG/Teamcgui.user $HOME/Teamcgui

chmod u+w $HOME/Teamcgui

Those advanced users who want to guarantee that the new Teamcgui changes are
loaded, they can do the following:

1. Exit teamcgui
2. xrdb -remove
3. xrdb -load Teamcgui

Intel - Customization files

In OS/2 and Windows, the teamcv3.ini file is stored where the operating system code is
stored, such as C:\OS2 or C:\WINDOWS. These files are updated through the settings page
of the teamcgui.

It is strongly recommended that the users should not attempt to edit this file; use the GUI
functions from File -> Task List -> Edit task list.

IS THERE A SAMPLE PROFILE FOR THE TEAMCONNECTION END
USER?

Because there are many environment variables that are needed for a VisualAge
TeamConnection family or end user, we provide sample profiles that have already defined
these variables. Some of them are commented out and the user needs to activate them by
deleting the comment mark (such as the one for each operating system), and others require a
real value instead of the place-holder value used in the sample.
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Unix - Sample profiles

The following sample profile can be used as the basis for the profile of a Unix user account
that will use TeamConnection (end-user):

1. Login as the end user.

2. Make a backup of the current profile.

cp .profile .profile.original

3. Copy the sample profile.

In AIX do the following (use /opt/teamc for HP-UX and Solaris):

cp /usr/teamc/nls/cfg/$LANG/profile.user .profile

chmod u+w .profile

4. Read the entire profile and delete the comment character (in the first column) of those
lines that are appropriate for the operating system to be used.

Also, use the appropriate values for your setup.

5. Logout and login again in order to start with a fresh environment.

Note that some users just restart the .profile without logging out and then logging in. The
problem is that there are some variables such as $PATH that uses a previous version of
itself, and thus, when logging out and then logging in, the PATH is properly set.

Intel - Profile information

Because the Intel operating systems are single user systems, the TeamConnection installation
script addresses all environmental configuration needs in the appropriate system files or reg-
istry.

However, the administrator should verify the setup for the TeamConnection and DB2 variables
such as TC_FAMILY and TC_BECOME, which will be used for line commands.

UNIX: HOW TO SEE THE CONTENTS OF FILES THAT ARE ACTIVE?

To see the up-to-date contents of the files that are active, such as nohup.out and the audit or
database logs, do the following:

1. Enter the following command:

tail -f filename

2. Observe that the output is scrolling when the file is being updated.

3. If it is no longer scrolling, then the file is not being updated anymore.
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4. Press Ctrl+C to exit from the tail command.

UNIX: HOW TO LINK FILES AND DIRECTORIES USING SYMBOLIC
LINKS?

� To establish a symbolic link between a 'real' file/directory and a 'shadow' file/directory do:

ln -s real-entity shadow-entity

The following example will allow the user to use "myFile" as if it were the real
"myFileWithLongName":

ln -s $HOME/bin/myFileWithLongName $HOME/myFile

� Use the following command in order to see the real file of a linked file:

ls -l fileName

Using the example above, the output of "ls -l myFile" would look like:

lrwxrwxrwx 1 rivera staff 9 Nov 17 ð9:22 myFile@ -> myFileWithLongName

Notes:

1. The first character in the file permissions is an "l" which indicates a "link".

2. The string "myFile@ -> myFileWithLongName" means that the file "myFile" is really
mapped to the real file "myFileWithLongName".

3. The "@" at the end of "myFile" indicates that is a symbolic link.

� Use the following command in order to see the real directory of a linked directory:

ls -dl directoryName

This is useful to avoid showing the actual contents of the directory, which is what you get if
you use "ls -l directoryName".

HOW TO FIND OUT ALL THE PROCESSES THAT ARE RUNNING?

Unix - processes

To see the processes that are running, do the following:

� To find out how many TeamConnection family server daemons are running on the entire
system:

ps -ef | grep teamcd

� To find out all of the processes running in a family account:

ps -fu FAMILY_ACCOUNT
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Where FAMILY_ACCOUNT is the name of your family.

In TeamConnection, there are different processes that are typically running: teamcd,
teamcbld and teamcgui. You will also intermittently see teamc and any miscellaneous
tools being run in the family account.

Intel - Processes

OS/2 - process status

pstat | more

 Windows

� You can use the Task Manager to find out which processes are running.

1. Select the task bar at the bottom of the screen (default location).

2. Click on the right button of the mouse and select "Task Manager".

3. Select the tab "Applications".

You will see the active applications, such as "TeamConnection - Tasks".

4. Select the tab "Processes".

You will see the list of processes and the real names of the executables, such as
"TEAMCGUI.EXE".

� You can also issue the command "net start" as follows:
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C:\>net start

These Windows NT services are started:

 Computer Browser

DB2 - DB2

DB2 - DB2DASðð

 EventLog

Lotus Domino Go Webserver

 Messenger

Plug and Play

Remote Procedure Call (RPC) Service

 Server

 Spooler

TCP/IP NetBIOS Helper

TME 1ð NetFinity Support Program

 TrcBoot

 Workstation

Figure 6. Output of 'net start' that shows Windows NT services

HOW TO PACKAGE AND COMPRESS FILES

Sometimes it is necessary to package a set of files into a single one in order to perform a
backup copy or to send them to another system. Furthermore, in order to save space, the file
that contains the packaged files can be compressed.

All platforms: using zip and unzip from Info-Zip

The VisualAge TeamConnection team uses the Info-Zip "zip" and "unzip" tools to package
compressed files (in which the files to be packaged are compressed first). The main advan-
tages of Info-ZIP are:

� Compatibility: these tools are compatible with other ZIP programs.

� Portability: they are available in ALL the platforms that are supported by VisualAge
TeamConnection.

Furthermore, a zip file prepared in Unix can be unzipped in the correct format in Windows
NT and vice versa. This is something that the other ZIP programs such as "gnuzip" or
"gzip" cannot do.

Info-ZIP's software (zip, unzip and related utilities) is free and can be obtained for the desired
platforms from various anonymous-ftp sites, including the URL:

ftp://ftp.uu.net:/pub/archiving/zip/
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To compress and package files do the following:

1. Change to the directory where you have the files to be processed.

2. Issue the following command to compress and package:

zip -r myfile.zip fileList

The -r flag indicates that if there are subdirectories, they need to be recursively traversed.

The fileList can be a single file (file.c), a list of files (file.c file.h) or using wildcards (file*).

3. To only view the contents of the zip file (without actually unpackaging and uncompressing
the files) do:

unzip -l myfile.zip

4. To unpackage and uncompress the zip file do:

unzip myfile.zip

5. To fine more information about these tools simply invoke them without any parameters.

Unix: using tar and compress

In case that you do not want to use the Info-Zip tools, you may want to do the following
process to package and compress files:

1. Change to the directory where you have the files to be packaged.

2. Issue the tar command to package the files (without compression):

tar -cvf file.tar fileList

The fileList can be a single file (file.c), a list of files (file.c file.h) or using wildcards (file*).

3. Issue the compress command to reduce the size of the tar file:

compress file.tar

The file will be compressed and the file name will be changed to reflect that it is com-
pressed. The new name will have a suffix of uppercase Z at the end, such as "file.tar.Z".

4. Issue the uncompress command to restore the tar file to its original size:

uncompress file.tar.Z

The file will be uncompressed and the file name will be changed to its original name, such
as "file.tar".

5. Issue the tar command to list the table of contents (without actually unpackaging the files)

tar -tvf file.tar

6. Issue the tar command to unpackage (extract) the files:

tar -xvf file.tar
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CR (CARRIAGE RETURN) AND LF (LINE FEED)

The end of a line of text in OS/2 or in Windows is represented by the character pair CR-LF
(carriage return and line feed), whereas in Unix is represented simply by the character LF (line
feed).

In TeamConnection, the model of what-you-see-is-what-you-get is used. This means that if a
user creates a file in TeamConnection, regardless of the platform of the server, then
TeamConnection will NOT do any conversion of LF or CRLF on that file. There are choices in
the -extract action to allow for more fine tuning of these on-the-fly-conversions. For example,
a Unix user may wish to extract with only LF a file that was stored originally from OS/2 that
has CRLF.

The following file will be the source file to be used in the rest of the examples in this section:

This is line 1

This is line 2

This is line 3

If the source file is created from an OS/2 client and later on is extracted into a Unix client
without CRLF conversion, then the resulting file will have the CR character at the end of each
line and the file would look like:

This is line 1^M

This is line 2^M

This is line 3^M

Note:  The ^ symbol is similar to an inverted V, located in the Shift position for the numeric
key "6" in the alphanumeric keyboard (not in the numeric keyboard in the right side) for
English for the USA.

If the source file is created from a Unix client and later on is extracted into an OS/2 client
without CRLF conversion, then the resulting file will not have the CR character at the end of
each line and the file would look like:

This is line 1

This is line 2

This is line 3
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Using the tool fixcrlf to fix CR-LF conversion problems

If you are encountering the CR-LF problems mentioned in “CR (carriage return) and LF (line
feed)” with your files when exchanging text files between Unix and Intel, then you can use the
fixcrlf  tool.

This tool can be obtained from the TeamConnection ftp site:

1. ftp ftp.software.ibm.com
2. login anonymous
3. cd ps/products/teamconnection/tools

 4. ascii
5. get fixcrlf.txt

 6. binary
7. Download the corresponding file for your platform:

 � AIX: aixfixcrlf
 � HP-UX: hpfixcrlf
 � Solaris: fixcrlf.solaris
 � OS/2: fixcrlf2.exe
 � Windows: fixcrlfw.exe

 8. quit

The file fixcrlf.txt provides more details about using the tool.

Also, you can simply invoke the tool with no parameters to find out how to use it.

VERIFYING THE CHECKSUM FOR FILES IN UNIX

The sum  command is generally used to determine if a file that has been copied or communi-
cated over transmission lines is an exact copy of the original. This command provides both
the checksum and the number of 1024-byte blocks for a given file, such as:

$ sum file1

55681 11 file1

\\\\\ --> number of blocks (1ð24-byte)

\\\\\ --> checksum

Note:  The sum command is implemented differently in each operating system and the results
will be different when running the command against the same file in different operating
systems.
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 CONNECTIVITY TASKS

This section describes some common tasks and useful information for testing the connectivity
between the TeamConnection client machine and the TeamConnection family server machine.

Sometimes it is important to test the connectivity of a host in order to properly diagnose a
problem.

1. The "teamc report -testServer" command is useful to determine if the TeamConnection
client can connect to the TeamConnection family server.

2. The ping command can be issued to find out if the host is operational.

3. The host command can be issued to find out if there is full reciprocity between a host
name and its IP address.

4. In case of problems with the ping or host command, some useful commands are
described to help with the debugging efforts.

TEST THE CONNECTION TO THE TEAMCONNECTION FAMILY
SERVER

You can use the command "teamc report -testServer" to verify if the TeamConnection client
has a good connection to the TeamConnection family server.

For example:

$ teamc report -testServer

Connect to Family Name: vatc

Server TCP/IP Name: tcaixð5.raleigh.ibm.com

Server IP Address: 9.67.238.38

Server TCP/IP Port Number: 26ðð

Server Specific Information ----------------------------------

Product Version: 3.ð.1

Operating System: AIX

Message catalog language: English

Server Mode: non-maintenance

Authentication Level: PASSWORD_OR_HOST

Figure 7. Output of 'teamc report -testServer'
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USING THE PING COMMAND

The "ping" command is the first tool that the user should use to diagnose possible network
problems.

The TCP/IP "ping" command can be used to test if a given host specified by a host name or
host IP address is registered as a valid host and actively connected to the network.

If the host name or IP address is not registered as a valid identifier, then the ping command
will fail.

If the host is active but not connected to the network then the "ping" command will not be able
to receive the expected message.

For example:

1. At a prompt, type "ping testfam".

If you receive information that is similar to the following, you can successfully connect to
your TeamConnection family:

PING testfam.company.com: 56 data bytes

64 bytes from 1.23.457.78: icmp_seg:ð. time=ð. ms

64 bytes from 1.23.456.78: icmp_seg:1. time=ð. ms

64 bytes from 1.23.456.78: icmp_seg:2. time=ð. ms

2. Press Ctrl+C to end the command. You may get the following summary:

--- testfam.company.com ping statistics ---

3 packets transmitted, 3 packets received, ð% packet loss

round-trip min/avg/max = ð/ð/ð ms

In Windows, the ping command only shows few lines and then it terminates by itself.

3. If you receive the message "unknown host testfam", you cannot connect to the family.
Verify that the data in the hosts and services files is correct, and then try the command
again.

If you still do not get the correct response, contact your TCP/IP administrator to solve the
problem.
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USING THE HOST COMMAND (OR EQUIVALENT)

In AIX and in OS/2 there is a command called "host" which gets the IP address given a host
name or vice versa. This command uses the local /etc/hosts file first, and if the host name or
the IP address is not found there, then the network name server is contacted next.

This command is not provided by TCP/IP in Solaris, HP-UX and Windows, but we provide in
the CD-ROMs for TeamConnection the command "tchost", which is a reduced version of the
AIX "host" command:

Platform location in CD-ROM

Windows NT samples/tchostw.exe

HP-UX misc/tchost.hp

Solaris misc/tchost.sol

The "host" command is used to ensure that a specified host name can be resolved to an IP
address, and correspondingly, that the same IP address is resolved to the specified host
name.

We have seen cases in which a host name is resolved to an IP address, but this IP address is
resolved to a different host. In these cases, it is important to first fix the TCP/IP configuration
problem and do NOT attempt to use TeamConnection until the TCP/IP problem is fixed.

Also, we have seen this problem when using DHCP in Windows 32-bit in which the host
receives a dynamic IP address that exists only for the duration of the session. In this cases it
is better to use the password authentication level (such as PASSWORD_ONLY or
PASSWORD_OR_HOST) for TeamConnection.

In some networks, there could be a mismatch between the host name and the IP address. Do
the following to verify that the hosts file is specified correctly:

1. Type "host family_name", where family_name is the name of your TeamConnection family.

The information returned should match the number and name specified in your hosts file.
For example:

host testfam

The system response might be as follows:

testfam.company.com = 9.12.345.67

2. Type "host ip_address", where ip_address is the IP address of your machine.

The information returned should match the output from the previous step (that is: host
testfam). For example:

host 9.12.345.67
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The system response might be as follows:

testfam.company.com = 9.12.345.67

If you do not receive the expected response, contact your TCP/IP administrator to solve
the problem.

In some networks the second step gives a different host name and this will cause prob-
lems with TeamConnection.

USING THE NSLOOKUP COMMAND

The TCP/IP "nslookup" command skips the local hosts file and queries directly the network
name server, thus its name: Name Server Look Up. It provides the host name and IP
address of the name server, followed by the target host name and IP address.

For example:

$ nslookup cordoba

Server: ralns1.raleigh.ibm.com

Address: 9.37.ð.5

Name: oem-ppc3.raleigh.ibm.com

Address: 9.37.199.98

Aliases: cordoba.raleigh.ibm.com

Figure 8. Output of 'nslookup'

LOOKING AT THE TCP/IP CONFIGURATION NOTEBOOK IN OS/2

In OS/2, you can look at the TCP/IP Configuration Notebook to find out the details on the
configuration of TCP/IP.

USING IPCONFIG IN WINDOWS NT

Windows NT provides the following utility to find out the actual TCP/IP values used with the
current communication session in your machine:

1. Open a Command Prompt window.

2. Issue: ipconfig
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Windows NT IP Configuration

Ethernet adapter NdisWan4:

IP Address. . . . . . . . . : 9.37.194.164

Subnet Mask . . . . . . . . : 255.255.24ð.ð

Default Gateway . . . . . . : 9.37.192.1

Figure 9. Output of 'ipconfig' in Windows NT

USING WINIPCFG IN WINDOWS 95

Windows 95 provides the following utility to find out the actual TCP/IP values used with the
current communication session in your machine:

1. Select Start -> Run...

2. From the Run window, enter the name: winipcfg

3. You will see a window titled "IP Configuration" and will have data such as:

Ethernet Adapter Information

 PPP Adapter

Adapter Address: 44-45-53-54-ðð-ðð

 IP Address: 32.225.77.1ð5

Subnet Mask: 255.ð.ð.ð

 Default Gateway: 32.225.77.1ð5

Figure 10. Output of 'winipcfg' in Windows 95

4. You can press the button "More Info >>" and then you will see the additional information
about the host, such as:

Host Information

 Host Name: xxx.raleigh.ibm.com

 DNS Server: 9.67.1.5

WHERE ARE THE HOST AND SERVICES FILES?

The "hosts" file is used to indicate the IP address of a host and aliases for that host. The
"services" file is used to indicate the port number of the service (TeamConnection family).
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Unix /etc/hosts and /etc/services

It is recommended that the system administration utilities should be used to
update these files, such as smit in AIX and sam in HP-UX.

OS/2 They are located in the directory described in the environment variable "etc".
To see the value for this variable type: set etc

Windows 95 They are located where the operating system is located, such as C:\WINDOWS
The "hosts" file by default does not exist, but it can be constructed from the
sample "Host.sam" which, by default, resides in C:\WINDOWS

Windows NT  They are located in the subdirectory SYSTEM32\DRIVERS\ETC, where the
operating system is located. The default is C:\WINNT

USING YPCAT WHEN THE HOST IS MANAGED BY NIS

When using NIS to control the userIDs, the groupIDs and the port numbers in the services file
of client machines from a central machine, you can use the command ypcat to find out more
details about the NIS maps:

� ypcat passwd (for /etc/passwd replacement/supplement)
� ypcat group (for /etc/group replacement/supplement)
� ypcat services (for /etc/services replacement/supplement)
� ypcat -x (to display the Nickname Translation Table, which indicate the things that are

mapped).

Please consult your local documentation to know how to tell which files are being supple-
mented or replaced.
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 ADMINISTRATIVE TASKS

This section describes some common tasks that the system administrators or the
TeamConnection family administrators are likely to do with the operating system.

WHICH ARE THE MAIN ADMINISTRATION TOOLS FOR THE
OPERATING SYSTEM?

Unix - Administrative GUI tools

AIX The main tool is "smit" for GUI or "smitty" for a character-based interface.

If you use telnet to login into a remote host and you issue "smit", if you have not
exported your DISPLAY environment variable, then the GUI session cannot be
started and thus, "smitty" is invoked instead.

You can look at the files ./smit.log and ./smit.script for the details on the com-
mands issued by smit and its associated results.

HP-UX The main tool is "sam" for GUI.

You can look at the files /var/adm/sw/sw*.log for the details on the installation
commands.

Solaris The main tool is "admintool" for GUI.

Intel - Administrative Tools

 OS/2

The vast majority of administrative actions can be found by opening the System Icon.

Windows NT and Windows 95

Generally performed administrative tasks are split between several icons. Here are the most
commonly used for TeamConnection administration:

� In Windows NT and Windows 95

The system administration facilities in Windows 95 are in the "Start" -> "Control Panel"
program selection.
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� In Windows NT, you can access other utilities by doing Start -> Programs -> Administrative
Tools

WHICH ARE THE MAIN ADMINISTRATION TOOLS FOR
TEAMCONNECTION?

The main administration tools for TeamConnection are:

� The TeamConnection Family Administrator (tcadmin) is described in “How to use the
TeamConnection Family Administrator.”

� The TeamConnection Activity Monitor (monitor) is described in “How to use the
TeamConnection Activity Monitor.”

How to use the TeamConnection Family Administrator

The VisualAge TeamConnection Family Administrator tool is a Java-based interface that
allows the family administrator to create and delete a TeamConnection family, modify config-
uration types and configurable fields, modify the authentication level for the family, modify the
authority and notification groups, etc.

How to use the TeamConnection Activity Monitor

The Activity Monitor is already included in tcadmin (right panel). However, a family adminis-
trator who wants to use a remote telnet session to monitor the activity of the family, can follow
these steps:

To find out what the family daemons are doing, use the TeamConnection Activity Monitor:

monitor 1

Where the number 1 is the number of seconds to refresh the output screen which looks like
this:

2 of 2 teamcd daemons running. Shared mem size is 2988.

Press any key to quit.

Total hits = 54

ð1,18148,ððð27,,

ð2,1841ð,ððð27,,

Figure 11. Output of 'monitor 1'
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The description of the fields is shown below:

� The first row indicates how many family daemons are active. The size of shared memory
is not too relevant, thus, do not worry about it.

� The second row indicates the total number of requests that all the family daemons have
processed since the family was started. When the family is stopped, then this number is
reset to 0.

� The rest of the rows show information about each daemon:

– The first column is simply an index number for each daemon.

– The second column indicates the process id for each daemon.

In case that you need to recycle this daemon (such as when a user is doing a query
such as "FileView, 1=1" which is not really a very relevant query and which will
degrade the performance for the rest of the daemons), then you can issue the fol-
lowing commands in this order:

1. "kill -1 processId"

This is a very gentle signal that tells the daemon to stop the current activity and to
reset itself ready for the next request.

It is most often used to force the daemon to re-read updated configuration files.

2. "kill -15 processId"

Use -15 if the previous -1 did not work.

This is a stronger signal that tells the daemon to stop the current activity and to
terminate as gracefully as possible. These daemon will not be able to handle more
requests.

These inactive daemons are identified in monitor by >> instead of an actual index
number in the first column.

3. "kill -9 processId"

Use -9 if the previous -15 did not work.

This is the strongest signal that tells the daemon to terminate now. This should be
used only as the last resource, because the daemons do not terminate gracefully.
These daemons will not be able to handle more requests.

These inactive daemons are identified in monitor by >> instead of an actual index
number in the first column.

– The third column indicates the number of hits for that particular daemon.

– The rest of the columns will show the current activity.
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IS THERE A SAMPLE PROFILE FOR A TEAMCONNECTION FAMILY?

Unix - Sample profiles

The following sample profile can be used as the basis for the profile of a Unix family account
that will use VisualAge TeamConnection:

1. Login as the family owner.

2. Make a backup of the current profile.

cp .profile .profile.original

3. Copy the sample profile.

In AIX do the following (use /opt/teamc for HP-UX and Solaris):

cp /usr/teamc/nls/cfg/$LANG/profile.family .profile

chmod u+w .profile

4. Read the entire profile and delete the comment character (in the first column) of those
lines that are appropriate for the operating system to be used.

Also, use the appropriate values for your setup.

5. Logout and login again in order to start with a fresh environment.

Intel - Profile information

Because the Intel operating systems are single user systems, the TeamConnection installation
script addresses all environmental configuration needs.

WHERE ARE THE ERROR MESSAGES FROM THE TC DAEMON AND
DATABASE?

Unix - syslog

Errors encountered by TeamConnection are recorded in the system log file (syslog) when the
syslog daemon (syslogd) is activated. If syslogd is not active, then the error messages are
sent to the console of the TeamConnection server workstation; however, these messages
eventually will scroll off the screen.

Because multiple families may be supported by a single TeamConnection server, the mes-
sages logged in syslog may pertain to multiple families.
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It is important to activate the syslog daemon so that TeamConnection errors and database
errors can be logged for subsequent problem resolution. Unfortunately by default (why?),
when you install the operating system in a machine, the syslog is not activated. Thus, you
may need to do the following to activate it.

To activate the syslog daemon do the following:

1. Login as root.

2. Use the touch command to create the syslog file if it does not exist already in the appro-
priate directory:

AIX touch /var/spool/syslog

HP-UX touch /var/adm/syslog/syslog.log

Solaris  touch /var/adm/messages

3. When creating the syslog file, set the file permissions according to the directions for the
operating system.

 � AIX:

chmod 666 /var/spool/syslog

chown root:system /var/spool/syslog

 � HP-UX:

chmod 666 /usr/adm/syslog/syslog.log

chown root:system /usr/adm/syslog/syslog.log

 � Solaris:

chmod 666 /var/adm/messages

chown root:system /var/adm/messages

Notes:

a. If you do not want to use "chmod 666", you can use any of the following:

chmod a=rw /var/adm/syslog

 or

chmod ugo=rw /var/adm/syslog

b. The command "chown root:system" is a short way to do the following:

chown root /var/spool/syslog

chgrp system /var/spool/syslog

4. Edit the /etc/syslog.conf file and add the following line:

Note:  You must use a tab character to separate the values.

AIX \.warning /var/spool/syslog

HP-UX \.warning /var/adm/syslog/syslog.log

Solaris  \.warning /var/adm/messages

5. Stop and restart syslogd after modifying syslog.conf and creating the log file.
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 a. AIX:

stopsrc -s syslogd

startsrc -s syslogd

 b. HP-UX:

There are 2 choices to force the syslog daemon (syslogd) to read again the contents of
the file /etc/syslog.conf:

� If the file /var/run/syslog.pid exists, then use:

kill -HUP cat /var/run/syslog.pid

 � Otherwise do:

$ ps -ef | grep syslogd

### Find the process ID (pid) of the syslogd process.

### Use the actual pid below:

$ kill -HUP pid

 c. Solaris

ps -ef | grep syslog

# Find the process id for syslogd

kill -9 <process-id-syslogd>

\\\\\\\\\\\\\\\\\\\\ => use the process id

/usr/sbin/syslogd

6. Verify that the syslog daemon is running:

ps -ef | grep syslog

You should see an entry for syslogd.

7. Verify that the syslog daemon is able to write into the syslog file. The following test case
can help you to determine if the syslog has been configured properly:

a. Login with a TeamConnection family id.

b. Use 'su root' and give a wrong password. This action will fail and will add a warning
message at the bottom of the syslog.

c. To quickly view the last 10 lines of the syslog, do:

tail <syslog-file-name>

\\\\\\\\\\\\\\\\\\ => use the appropriate name

d. If the syslog is properly set and running, then a message similar to this one will be
added to the syslog:

Apr 19 hostname su: BAD SU from user ID to root at /dev/pts/3

 or

May 1 oem-hpð3 syslog: su : - ttyp1 cmhp3ora-root

8. If you want to cleanup the syslog, you can use the following command:
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cp /dev/null <syslog-file-name>

\\\\\\\\\\\\\\\\ => use the appropriate name

Maintaining the syslog

Monitor the syslog file at regular intervals so that any required maintenance or problem resol-
ution can be performed.

Because the syslog is a file that will grow overtime, it is highly recommended to have a set of
syslog files which can be rolled periodically in order to avoid having a syslog that is too large
and that has very old information that is obsolete.

For example, a syslog file can be copied into syslog.1 and this new file can be compressed;
later on the file syslog.1 can be renamed syslog.2, and the normal syslog can be copied as
syslog.1 and compressed Usually a set of 4 such backup files is sufficient, and thus the file
syslog.4 can be deleted during the rolling of the files.

Intel - syslog

The syslog facility is not a native application for OS/2 and Windows, TeamConnection pro-
vides an application specific syslog.

The syslog file resides in the sample location where the TeamConnection Family Server
(teamcd.exe) resides, and it is called "syslog.log".

HOW TO DETERMINE THE PATCHES APPLIED TO THE SYSTEM?

Sometimes it is necessary to determine if there are patches or PTFs or fixpaks applied for an
application or the operating system. You can use the commands in this section to find this
information.

 AIX

To find out the installed filesets or fileset updates in AIX 4, you can use the following
command:

� To list all the filesets:

lslpp -l -a | more

� To list all the filesets that have a common name, such as for "db2*":

lslpp -l -a "db2\" | more
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An example of the output is shown below:

 Fileset Level State Description

 ----------------------------------------------------------------------------

Path: /usr/lib/objrepos

 db2_ð5_ðð.adt.rte 5.ð.ð.ð COMMITTED DB2 Application Development

 Tools (ADT)

 db2_ð5_ðð.adt.samples 5.ð.ð.ð COMMITTED DB2 ADT Sample Programs

 db2_ð5_ðð.client 5.ð.ð.ð COMMITTED DB2 Client Application Enabler

5.ð.ð.2ð COMMITTED DB2 Client Application Enabler

Figure 12. Output of 'lslpp' command

Notice that the first entry for the db2_05_00.client is the original installation (version
5.0.0.0) and the second entry is the fixpak (version 5.0.0.20).

 HP-UX

To find out the installed filesets/products in HP-UX 10 you can use the following commands:

� To list the bundles and products

$ swlist | more

# Initializing...

# Contacting target "oem-hp1ð"...

#

# Target: oem-hp1ð:/

#

#

# Bundle(s):

#

B2617CBEng C.ð5.25.ð1 English C++ SoftBench S7ðð 1ð.x

LOTUSGO 4.6.1 Lotus Domino Go Webserver

#

# Product(s) not contained in a Bundle:

#

DB2V5CAE 5.ð.ð DB2 Client Application Enabler for HP-UX

PDB2_ð4ð57 5.ð.ð DB2 Product Patch

PHCO_14175 B.1ð.ðð.ðð.AA mount(1M) cumulative patch

Figure 13. Output of 'swlist'
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� To list all the products:

$ swlist -l product | more

# Initializing...

# Contacting target "oem-hp1ð"...

#

# Target: oem-hp1ð:/

#

DB2V5CAE 5.ð.ð DB2 Client Application Enabler for HP-UX

DB2V5ENTP 5.ð.ð DB2 UDB Enterprise Edition for HP-UX

PHCO_14175 B.1ð.ðð.ðð.AA mount(1M) cumulative patch

Figure 14. Output of 'swlist -l product'

� To list all the products that have a certain string in the name:

$ swlist -l product "DB2\" | more

# Initializing...

# Contacting target "oem-hp1ð"...

#

# Target: oem-hp1ð:/

#

DB2V5CAE 5.ð.ð DB2 Client Application Enabler for HP-UX

DB2V5CONN 5.ð.ð DB2 Connect Enterprise Edition for HP-UX

DB2V5ENTP 5.ð.ð DB2 UDB Enterprise Edition for HP-UX

Figure 15. Output of 'swlist -l product "DB2*" '

� To list the individual filesets:
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$ swlist -l fileset | more

# Initializing...

# Contacting target "oem-hp1ð"...

#

# Target: oem-hp1ð:/

#

# DB2V5CAE 5.ð.ð DB2 Client Application Enabler for HP-UX

 DB2V5CAE.client 5.ð.ð DB2 Client Application Enabler

DB2V5CAE.convucs 5.ð.ð Code Page Conversion Tables - Uni Code Support

DB2V5CAE.jdbc 5.ð.ð Java Database Connectivity (JDBC) Support

DB2V5CAE.odbc 5.ð.ð Open Database Connectivity (ODBC) Support

Figure 16. Output of 'swlist -l fileset "DB2*" '

 Solaris

To find out the installed filesets/products in Solaris you can use the following commands:

� To list the applications and products:

$ pkginfo | more

application CICSmsg CICS messages

system PFUagaow AG-1ð DDX Support(OpenWindows)

application db2cliv5ð DB2 Client Application Enabler

application db2engn5ð DB2 Engine

Figure 17. Output of 'pkginfo'

� To list a subset of the products:

$ pkginfo | grep -i db2

application db2cliv5ð DB2 Client Application Enabler

application db2engn5ð DB2 Engine

Figure 18. Output of 'pkginfo | grep -i db2'

� To list the patches:

38 How to do routine operating system tasks  



   
 

$ showrev -p | more

Patch: 1ð1242-12 Obsoletes: Packages: SUNWlibC 5.6,REV=97.ð3.ð5,PATCH=12

Patch: 1ð3663-ð8 Obsoletes: 1ð3683-ð1, Requires:, Incompatibles:, iss_sparc-ð1

 Packages: SUNWcsu, SUNWcsr, SUNWhea

Figure 19. Output of 'showrev -p'

Role of /var/sadm/patch in Solaris

The following directory has one subdirectory for each patch that has been applied to the
system:

/var/sadm/patch

The naming convention for system patches is "patch_name-version", such as the patch
required by DB2: 103600-13. However, at the time of writing this TR, we got a patch version
that is more recent: 103600-18. Notice that this latest version 18 includes the explicit version
13 required by DB2.

Thus in our machine, we have the following subdirectory that contains more information about
the version 18 of patch 103600:

/var/sadm/patch/1ð36ðð-18

 Windows

To determine the version and level of the currently installed DB2 product in Windows, type
"regedit" from an MS-DOS command prompt and check the following values under the registry
key HKEY_LOCAL_MACHINE\SOFTWARE\IBM\DB2\<product name>\Current Version. The
values should be the following:

 Version "ðxððððððð5" (5)

 Release "ðxðððððððð" (ð)

 Modification "ðxðððððððð" (ð)

 Service Level ""

 OS/2

To determine the version and level of the currently installed DB2 product in OS/2, do the fol-
lowing:

1. Double-click on the 'Installation Utility' icon in the 'DB2 for OS/2' folder.
2. Select 'View', 'Installed Products'.
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3. Select the appropriate DB2 product.
4. Select 'Details', 'Product Status'. The version should be 05.00.00.
5. Select a component. Click on 'Service level'. The level should be 0000000.

HOW TO CREATE GROUPS AND USERS

 Unix

For example, to create a user ID called db2inst1 which will use db2iadm1 as its primary group
and use /home/db2inst1 as its home directory:

 � AIX

Use SMIT to create the groups and user IDs, or you can issue the following commands:

mkgroup db2iadm1

mkuser pgrp=db2iadm1 groups=db2iadm1 home=/home/db2inst1 db2inst1

passwd db2inst1

 � HP-UX

Use SAM to create the groups and user IDs, or you can issue the following commands:

groupadd db2iadm1

useradd -g db2iadm1 -d /home/db2inst1 -m db2inst1

passwd db2inst1

 � Solaris

Use the AdminTool to create the groups and user IDs, or you can issue the following com-
mands:

groupadd db2iadm1

useradd -g db2iadm1 -d /export/home/db2inst1 -m db2inst1

passwd db2inst1

 Intel

In OS/2 there are no facilities for users and groups.

In Windows NT, you can use Start -> Programs -> Administrative Tools -> User Management,
to create users and groups.

HOW TO CHANGE THE OWNER/GROUP OF A FILE
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Unix - chown

For all platforms you can use the following command:

chown user:group file

Notes:

1. Using the command 'ls -l' will show both the owner and the group.

2. The command "chown user:group" is a short way to do the following:

chown user file

chgrp group file

Intel - file ownership

Intel operating systems do not have the concept of ownership for ordinary files. Windows 95
and NT do maintain separate configuration files for each user login, but this is not a general
purpose feature.

HOW TO EXPORT DIRECTORIES TO BE MOUNTED BY OTHER
HOSTS?

This section assumes that you are using TCP/IP and the NFS daemon to export your
filesystems. For Intel platforms and AIX there is support for IBM OS/2 Warp Server and other
traditional Intel "net use" facilities.

Unix - exporting directories

Finding out what directories are exported

A quick way to find out what directories are exported from the local host, enter:

exportfs -v

An example of the output is:

/home/buildtc -rw

/disk2 -root=oem-ibm,access=oem-ibm

In the above output, the file system /home/buildtc can be read and write by everybody (-rw),
and the file system /disk2 can be accessed only from the oem-ibm host which also has root
privilege.
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AIX - /etc/exports

You can use the smit tool to specify the directories to be exported; this information is stored in
/etc/exports:

1. Login as root.
2. Enter smit (GUI) or smitty (ASCII)
3. Select "Communications Applications and Services"
4. Select "NFS"
5. Select "Network File System"
6. Select "Add a Directory to exports lists"

AIX also allows client access to IBM OS/2 Warp Server drivers through "net use", starting with
AIX 4.1.4.

 HP-UX

You can use the sam tool to specify the directories to be exported; this information is stored in
/etc/exports:

1. Login as root.
2. At the command prompt, enter sam.
3. Double click on the Networking and Communications icon.
4. Double click on the Networked File Systems icon.
5. Double click on the Exported Local Filesystems icon.
6. From the menu bar, select Actions. Then select Add Exported File System.
7. In the Local Directory Name field, enter the absolute path name of the directory to export.

Also select other options on the same screen as appropriate for your system.
8. Then click on the OK box. This will export your directory to the specified machines imme-

diately.

 Solaris

The Solaris admintool does not provide a convenient method of updating /etc/dfs, so we have
provided the manual process below:

1. Login as root.
2. Change directory to /etc/dfs.
3. Edit the file dfstab which is a file containing commands for sharing resources across a

network. Append a share command to the end of this file. Use the man command to find
out more information about the share command. Add a share command in the dfstab file.
For example:

share -F nfs -o rw=host -d "teamc client" /export/home/dir
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4. Save and exit the file.
5. For the export to take effect immediately, execute the same share command on the

command line.

Intel - Exporting directories or drives

 OS/2

IBM TCP/IP provides an NFS daemon, which is compatible with the latest TCP/IP versions,
but for a strange marketing reason it is not delivered anymore with TCP/IP. Since NFS is a
separate product from the operating system we will only cover this facility briefly.

1. Add export directories by updating the "exports" file in the directory pointed to by the ETC
environment variable.

2. Restart TCP/IP with the "tcpstart" command.

3. Verify the new export with the "showexp SYSTEM_NAME" command.

Note:  We have found the "showexp" command to be unique to OS/2. It is very useful for
checking NFS exports in a heterogeneous environment.

The latest NFS 2.0 CSC is UN57064, and can be downloaded via anonymous ftp from:

ftp.software.ibm.com

cd /ps/products/tcpip/fixes/v2.ðos2/un57ð64

However, there are extra fixes that have not been formally packaged as a CSD that can be
downloaded from the same ftp site, under a different directory:

cc /ps/products/tcpip/fixes/nfslatest

You should first apply the CSD then the fixes from the nfslatest directory.

Windows NT and Windows 95

The operating system does NOT support an NFS daemon, which is the process that manages
an NFS exported directory, in the operating system.

The NFS server for this platform is provided by third-party vendors. Follow the instructions
provided by the vendor.

HOW TO MOUNT DIRECTORIES EXPORTED BY A REMOTE HOST?
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Unix - mount command

The best way to mount directories that are exported by a remote host is to use the system
administration tool. If you have mounted directories as part of your normal system configura-
tion, you can use the system administration tool and have the operating system mount the
directories during bootup and initialization. Note that if your network is experiencing problems,
your system may hang or take a long time to complete the bootup process.

Mounting directories using manual commands

1. Login as root.

2. Create an empty directory which will be the mount point. That is, after the remote file
system is mounted to the local mount point, this local mount point will represent the top
directory for the mounted system.

3. Enter the following command:

mount carcps21:/home/build /home/build

 | | |

 host remote directory local directory

to be mounted

4. To look at the mounted file systems, you can use either of the following commands:

 � mount

 � df -k

Note: In HP-UX, it is better to use "bdf" instead of "df".

 AIX mount

AIX supports administering mounts through smit:

1. Login as root.
 2. smit

3. System Storage Management (Physical & Logical Storage)
4. File Systems
5. Mount a File System
6. Specify the details.

AIX also supports "net use" for drives exported by OS/2 Warp Server.
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 HP-UX mount

HP-UX supports administering mounts through sam:

1. Login as root.
 2. sam

3. Disks and File Systems
4. File Systems
5. Select "Actions", then "Add Remote File System".
6. Specify the details.

 Solaris mount

The admintool does not support the administration of mounts. Thus, you need to perform this
administration by using the mount command.

Intel - mount command

 OS/2:

OS/2 mount syntax:

mount carwin1ð:c:\home\build x:

 | | | |

 host remote remote directory local drive

drive if to be mounted

 an Intel

 Server

Windows NT and Windows 95

The operating system does NOT support an NFS client (the process that mounts an exported
file system from a remote host) in the operating system.

The NFS client for this platform is provided by third-party vendors. Follow the instructions
provided by the vendor.
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 USING CD-ROMS

CD-ROM is the only medium IBM provides for installing the complete VisualAge
TeamConnection package. The use the TeamConnection CD-ROM is well documented in the
VisualAge TeamConnection Installation Guide.

AIX - CD-ROMs

Before you can use a CD-ROM in AIX, you have to mount the CD-ROM. Once the CD-ROM
is mounted, then you can access it.

Mounting a CD-ROM in AIX

1. Insert the CD-ROM into the CD-ROM drive.

2. Log in as user root or do "su - root" to login as root and use the profile.

3. Create a directory for the CD-ROM /cdrom by entering mkdir /cdrom.

4. Enter smit to add a CD-ROM file system.

5. Select "System Storage Management (Physical & Logical Storage)"

6. Select "File Systems"

7. Select "Add / Change / Show / Delete File Systems."

8. Select "CDROM File Systems"

9. Select "Add a CDROM File System"

10. Select a "Device name", such as "cd0".

The CD-ROM file system device names must be unique. You may need to delete a previ-
ously defined CD-ROM file system if there is a conflict.

11. Type "/cdrom" for "Mount Point".

12. Select "OK" (or press enter if using the smit ASCII interface).

13. Return to the previous smit level, "System Storage Management (Physical & Logical
Storage)"

14. Select "File Systems".

15. Select "Mount a File System".

16. Select "/dev/cd0" for "File System name".

17. Select "/cdrom" for "Directory over which to mount".

18. Select "cdrfs" for "Type of file system".
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19. Select "yes" for "Mount as a READ-ONLY system.".

20. Select "OK" (or press enter if using the smit ASCII interface).

21. Exit smit.

Now you are ready to use the CD-ROM.

Using a CD-ROM in AIX

After the CD-ROM is mounted, then you can use the CD-ROM. You can change the directory
to /cdrom and work with the files contained in it.

After you have finished with the CD-ROM, you need to do the following in order to be able to
remove the CD-ROM:

1. Log in with root authority.
2. Change to a directory that is not in /cdrom, to avoid a message saying that the device is

busy.
3. Unmount the CD-ROM:

umount /cdrom

4. Press the eject button from the CD-ROM drive.

HP-UX - Using CD-ROMs

Before you can use a CD-ROM in HP-UX, you have to mount the CD-ROM. Once the
CD-ROM is mounted, then you can access it.

HP-UX - Mounting a CD-ROM

Do the following to add and mount a CD-ROM file system:

1. Insert the installation CD into the CD-ROM drive.

2. Log in as user ROOT or type su - root.

3. Issue the mount command to determine if the CD-ROM file system is mounted and opera-
tional.

Verify that /CDROM is listed; if, not, then do the following:

a. To create a directory for the CD-ROM, type mkdir /CDROM.
b. Type: sam &
c. Select Disks and File Systems.
d. Select Disk Devices.
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e. Select the entry for a CD-ROM.
f. From the menu bar select "Actions" and choose the option "View More Iinformation...".

Disregard any warnings that say that the system cannot get information from an
unused device.

g. Click on Show Device Files...
h. Write down the value for a "Block device file", such as /dev/dsk/c1t2d0

Do not select raw devices such as /dev/rdsk/c1t2d0.
i. Close the Device Files window.
j. Close the View More Information window.

k. Exit from the Disks and File Systems window.
l. Exit sam.

m. To mount the CD-ROM device file identified above, type:

mount /dev/dsk/cðt2dð /CDROM

n. Issue the mount command again and verify that /CDROM is listed.

Using a CD-ROM in HP-UX

After the CD-ROM is mounted, then you can use the CD-ROM. You can change the directory
to /cdrom and work with the files contained in it.

After you have finished with the CD-ROM, you need to do the following in order to be able to
remove the CD-ROM:

1. Log in with root authority.
2. Change to a directory that is not in /cdrom, to avoid a message saying that the device is

busy.
3. Unmount the CD-ROM:

umount /cdrom

4. Press the eject button from the CD-ROM drive.

Solaris - Using CD-ROMs

There is no need to mount the CD-ROM if the Volume Management is running. Once you
insert the CD-ROM into the drive, the operating system mounts it for you.

If Volume Management is not running, do the following to mount the CD-ROM:

1. Login as root.

2. Start the Volume Management daemon by executing the following command:

/etc/init.d/volmgt start
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3. Execute ps -ef | grep vold. You should see the process "/usr/sbin/vold" started.

Using a CD-ROM in Solaris

After the CD-ROM is mounted (automatically or manually), then you can use the CD-ROM.
You can change the directory to /cdrom and work with the files contained in it.

After you have finished with the CD-ROM, you need to do the following in order to be able to
remove the CD-ROM:

1. Log in with root authority.
2. Change to a directory that is not in /cdrom, to avoid a message saying that the device is

busy.
3. Unmount the CD-ROM if the Volume Manager is not running and you had to manually

mount the CD-ROM

umount /cdrom

4. Eject the CD-ROM by typing the following command:

eject cdrom

Detecting if media has been inserted

In Solaris, the command volcheck  can be used to check if a CD-ROM has been inserted in
the driver, such as follows:

$ volcheck -v /cdrom

/cdrom has no media

Intel - CD-ROMs

In Intel operating systems, the CD-ROM drive is recognized by the operating system during
boot and is treated as a read-only drive.

HOW TO SHUTDOWN AND REBOOT THE MACHINES?

Unix - shutdown
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Miscellaneous notes before shutdown

In order to efficiently shutdown a system, it is recommended that you follow these suggestions
before you actually shutdown the system:

1. It is recommended to shutdown your system from a local session that does not use a
windowing system (otherwise, the shutdown time will be longer because the windowing
system has to be shutdown too).

2. If possible, unmount all the mounted NFS file systems.

Miscellaneous notes after reboot

After the system has been rebooted, it is suggested that you should manually remount the
necessary NFS file systems and if desired, start specific processes that may not be started
automatically after reboot, such as the database server.

Sometimes it is not convenient to automatically mount NFS file systems. For example, Host A
and Host B are being rebooted at the same time. If Host B NFS mounts directories from Host
A, Host B will hang during bootup until Host A is completely initialized and has its nfsd and
mountd daemons running. Then Host B can NFS mount directories from Host A and complete
its bootup.

It is also convenient to startup processes only when they are needed, such as databases.
This is advantageous when you know that the system is heavily used and when there is no
need for some databases to be running all the time.

In order to facilitate these tasks, you can, as root, create a shell script that will mount the
necessary NFS file systems and start the desired processes. In our site we have the conven-
tion that this shell script is located in the root directory, it has file permissions for execute, it is
named after the hostname and it has a suffix of ".mounts"; for example, in the host
"oem-hp01", the shell script is called "/oem-ppc3.mounts" and its contents is:

#!/usr/bin/ksh

# Enter here the mounts that need to be done manually:

mount tcaixð5:/home/build /home/build

mount tcaixð5:/tcinstall /tcinstall

# end of file

Figure 20. Example shell script to mount file systems
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AIX - shutdown

1. Login as root.

2. Enter the following command to shutdown and reboot (quick restart):

shutdown -Fr

HP-UX - shutdown

1. Login as root.

2. Enter the following command to shutdown and reboot:

shutdown -r

Solaris - shutdown

1. Login as root.

2. Enter the following command to shutdown and reboot:

shutdown -i6 -y -gð

Intel - How to shutdown and reboot

OS/2 - setboot

The OS/2 "setboot /b" command will cause OS/2 to shutdown and reboot.

You can also manually specify Shut Down from the desktop menu (point to the desktop and
click right button).

 Windows NT

� You can manually select "Start" then "Shut Down" and then specify the desired level for
shutdown and reboot.

� You can use the utility "reboot" from the Windows NT Resource Kit.

 Administrative Tasks 51



   
 

 Windows 95

You can manually select "Start" then "Shut Down" and then specify the desired level for shut-
down and reboot.

HOW TO STARTUP AN APPLICATION UPON BOOT AND REBOOT

 Unix Systems

The easiest method to automatically startup an application upon booting the Unix system is to
create an rc.xxxx file in /etc and add a corresponding entry in /etc/inittab.

If you have installed DB2 UDB V5 and created DB2 instances which are started upon boot,
then take a look at the following file:

/etc/rc.db2

Below is a sample of an /etc/rc.teamcd for TeamConnection (this is as-is code):
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#!/usr/bin/ksh

#######################################################################

# NAME: rc.teamcd

# FUNCTION: rc.teamcd - auto start TeamConnection on boot

# CUSTOMIZATION NOTES:

#

# This script is designed to be executed on reboot. Do the following

# to enable auto-starting of TeamConnection daemons.

#

# 1) You must modify this file to reflect the values used in your

# system. A strong recommendation for administering TeamConnection

# families is to use the same name for both the userId and family:

# 1.a) replace familyUserId with the appropriate value.

# 1.b) replace familyName with the appropriate value.

# 1.c) replace 2 with appropriate value of family daemons

# Note: To avoid your system from failing on reboot, it is recommended

# that you should very careful when changing the file.

#

# 2) After you have edited the file, you need to do the following:

# 2.a) copy this file as /etc/rc.teamcd

# 2.b) mark the file as executable: chmod u+x /etc/rc.teamcd

# 2.c) add the following line to /etc/inittab (of course without

# the comment characters in the first column):

# teamcd:2:once:/etc/rc.teamcd > /dev/console 2>&1 # Start TC

#######################################################################

# Wait for DB2 processes to start

while (( $(ps -ef | grep db2 | wc -l) == 1 ))

do

 sleep 6ð

done

# One extra sleep for all DB2 processes to start

sleep 1ð

# Define for each family. You MUST replace the values for

# familyUserId and familyName. Also, you may specify a different number

# of family server daemons other than 2:

su - familyUserId -c 'teamcd familyName 2;exit'

exit ð

Figure 21. /etc/rc.teamcd - Sample of auto start TeamConnection on boot

The comments in this file also indicate that the following line needs to be appended to the end
of /etc/inittab:

teamc:2:once:/etc/rc.teamcd > /dev/console 2>&1 # Start TC
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Additionally, for HP-UX and Solaris, there are recommended startup and configuration models
that can be implemented to start applications during system boot. Some references are pro-
vided below:

 � HP-UX 10.x

HP-UX 1ð.X Startup and Configuration White paper

Document ID : SRL96ð8ð3ð7

 � Solaris

Solaris System Administrator's Guide, Second Edition by Janice Winsor

ADDITIONAL PROCESSING IN SOLARIS

Below is an example procedure for autostarting TeamConnection using the Solaris recom-
mended method for starting applications.

1. Create file /etc/rc2.d/S99teamcd. If you are using a method similar to the one described
above (using rc.teamcd), then rename /etc/rc.teamcd to /etc/rc2.d/S99teamcd.

2. Remove the teamc entry from /etc/inittab

 OS/2

Place a shadow of the desired application in the StartUp folder in the OS/2 System folder.

 Windows

Place a shortcut of the desired application in the Start folder:

1. Select the taskbar and click on the right mouse button to select the Properties.

2. In the Taskbar Properties dialog, select the tab Start Menu Programs.

3. Select Advanced. You will see the window Exploring - Start Menu.

4. Expand Programs and select the folder StartUp.

5. In StartUp add the shortcuts of the desired applications.

If the application is a "service" then use the Services dialog: Start -> Settings -> Control
Panel -> Services

HOW TO FIND OUT THE AVAILABLE SPACE IN A FILE SYSTEM
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Unix - Space in a file system

To show, in kilobytes, the space left in the file system, use:

AIX df -k

Without "-k" the default is 512 byte blocks.

HP-UX bdf

Notice that in HP-UX the command "df -k" provides an output that is not easier
to interpret. We recommend to use "bdf" which provides an output that is
similar to "df -k" from AIX and Solaris.

Solaris  df -k

Without "-k" the default is 512 byte blocks.

An example of the output is:

$ df -k

Filesystem 1ð24-blocks Free %Used Iused %Iused Mounted on

/dev/hd4 16384 8728 47% 1341 17% /

/dev/hd2 15ð3232 475716 69% 4ð565 11% /usr

/dev/hd9var 16384 13584 18% 193 5% /var

/dev/hd3 8192ð 52ððð 37% 246 2% /tmp

/dev/hd1 241664 17564ð 28% 71ð 2% /home

/dev/disk2 15ð3232 244ð28 84% 12672 4% /disk2

Figure 22. Output of 'df -k' in AIX and Solaris (bdf in HP-UX)

Notice that if the -k flag is not used, then the values for the 2nd and 3rd columns will be in
512-byte blocks, which are not that intuitive to read.

To display the statistics for one mounted file system, enter:

$ df -k /home/buildtc

The output should look like this:

Filesystem 1ð24-blocks Free %Used Iused %Iused Mounted on

/dev/extra3lv 15278ð8 472684 7ð% 1752 1% /home/buildtc

Intel - Space on each drive

To show the space available on any logical disk drive, use:

dir /w [DRIVE-LETTER]
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or

chkdsk [DRIVE-LETTER]

 Windows

In Windows you can open My Computer, then select the desired drive, click with the right
mouse button, then select Properties from the context sensitive menu, and one of the items is
"Free space".

HOW TO EXPAND THE SIZE OF A FILE SYSTEM

Keep in mind the following suggestions when you increase/expand the size of a file system:

� For all practical purposes, you cannot shrink/reduce the size of a file system. Therefore,
try to be conservative on how much you increase a file system.

� Try to keep unallocated space in the volume group in order to be used as reserve for other
file systems. That is, if you do not have a compelling reason, try to not allocate all the
remaining space to one file system (keep something in reserve).

� Increase the size in several iterations, using smaller chunks (50 of 100 MB) at a time,
instead of a very large increase (1 GB) at once. For example, use 2 windows: one with
smit to add 100 MB, and in the other issue the "df -k" to verify that the increase was
properly done.

 AIX

To expand the size of a file system in AIX, it is necessary to perform the following activities:

1. Login as root.
2. Display the current statistics of the mounted file systems to find out the baseline values

before attempting to increase the file system. For details see “How to find out the avail-
able space in a file system” on page 54.

3. Identify the logical volume and the volume group for a given file system. For details see
“How to identify Logical Volume and Volume Group for a File System” on page 57.

4. Find out if there is unallocated space in the volume group that can be allocated to expand
a file system. For details see “How to find out the space left in a volume group” on
page 57.

5. If there is disk space in the volume group, then reallocate space to the file system. For
details see “Adding more disk space to a file system” on page 58.

6. Display the new statistics of the mounted file systems in order to compare them with the
baseline values. For details see “How to find out the available space in a file system” on
page 54.
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How to identify Logical Volume and Volume Group for a File System

Perform the following activities as user ID root:

smit

System Storage Management (Physical & Logical Storage)

Logical Volume Manager

 Logical Volumes

List All Logical Volumes by Volume Group

The output will look like this:

extra3vg:

LV NAME TYPE LPs PPs PVs LV STATE MOUNT POINT

extra3lv jfs 25ð 25ð 1 open/syncd /home/buildtc

In this case the file system /home/buildtc (identified by the column MOUNT POINT) belongs to
the logical volume extra3lv (identified by the column LV NAME), which in turns belongs to the
volume group extra3vg (above the LV NAME column).

It is a good convention to use the suffix "lv" for logical volume and "vg" for volume group. In
this case, there is a 3rd disk, named extra3, which has the volume group extra3vg and which
in turn has the logical volume extra3lv.

How to find out the space left in a volume group

Perform the following activities as user ID root:

smit

System Storage Management (Physical & Logical Storage)

Logical Volume Manager

 Volume Groups

List Contents of a Volume Group

Select the VOLUME GROUP name by using F4

Specify in the List OPTION: status

From the output, the key values are located in the right column:

PP SIZE: 4 megabytes

TOTAL PPs: xxx (yyy in megabytes)

FREE PPs: xxx (yyy in megabytes)

Where PP is a Physical Partition.
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Adding more disk space to a file system

Perform the following activities as user ID root:

smit

System Storage Management (Physical & Logical Storage)

 File Systems

Add / Change / Show / Delete File Systems

Journaled File Systems

Change / Show Characteristics of a Journaled File System

Select the desired file system

Then specify the SIZE of file system (in 512-byte blocks). For example, add the following to
the existing value:

� To add approximately 50 MB, you should add 100000 blocks (one hundred thousand).

� To add approximately 100 MB, you should add 200000 blocks (two hundred thousand).

Hint: you may position the cursor in the 6th position from the right, and just add the value
2 to the existing digit.

 HP-UX

There are two methods to expand the size of a file system in HP-UX according to the type of
file system:

� User defined logical volume, which are defined by the user. See “Expanding a user
defined logical volume.”

� System related logical volume, which are used by the operating system such as /opt. See
“Expanding a user defined logical volume” on page 59.

Expanding a user defined logical volume

To expand the size of a user defined file system in HP-UX, perform the following steps:

1. Login as root.
2. Use the export command to export your DISPLAY environment.
3. Invoke the System Administration Management tool by typing: sam &
4. Select the Disks and File Systems Icon.
5. Select the Logical Volumes Icon and find the logical volume that needs to be increased.
6. Then select Increase Size from the Actions pull down menu.
7. The space available in the volume group will be displayed. Enter the new TOTAL size of

the logical volume. For example, if the logical volume is currently at 100 MB and you want
to grow the logical volume by an additional 100 MB, then the New Size to enter will be
200.
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8. Select the OK button.

If there is no available space in the volume group, you will have to install another physical
drive to the machine and use SAM to add it to the volume group.

Expanding a user defined logical volume

While the procedure mentioned in “Expanding a user defined logical volume” on page 58 is
successful on user defined logical volumes, it will not work on system related logical volumes
such as /opt. This is because HP-UX cannot increase a logical volume it is using.

In order to increase space on a system logical volume, follow the steps below:

1. Login as root with no windows.
2. Shutdown the operating system to single user mode by entering the command at the

prompt:

/etc/shutdown ð

3. Unmount the filesystem you want to increase. For example, to unmount /opt, enter:

umount /opt

4. Use the lvextend  command to grow the logical volume size.

As an example, to increase the size of logical volume /dev/vg00/lvol5 that is mounted to
mount point /opt from 100 MB to 200 MB, enter:

lvextend -L 2ðð /dev/vgðð/lvol5

5. Use the extendfs  command on the raw device file.

To extend the filesystem in our example, enter:

extendfs /dev/vgðð/rlvol5

6. Reboot the system:

/etc/shutdown -r ð

 Solaris

The Solstice DiskSuite utilities can be used to expand a mounted or unmounted UFS file
system. Only UFS file systems can be expanded using these utilities. At the print time of this
technical report, the Solstice DiskSuite utilties were not part of the operating system and can
be installed from a separate product cdrom named Solstice DiskSuite Tool. Please refer to
the Solstice DiskSuite Administration Guide and the Solstice DiskSuite User's Guide for
detailed procedures on expanding file systems.
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 Intel

To modify the size of a disk partition in OS/2 and Windows, you can use specialized utilities
such as Partition Magic.

UNIX: HOW TO IDENTIFY AND KILL SEMAPHORES AND FREE
SHARED MEMORY?

To cleanup the semaphores and shared memory used by one TeamConnection family, you
can do one of the following:

� Use the TeamConnection utility /usr/teamc/bin/stopteamc which also stops the
TeamConnection daemons.

� Perform the following manual procedure:

1. Login as root.

2. Enter the following command to show the semaphores:

ipcs -s

3. Enter the following command to kill a semaphore:

ipcrm -s xxx

Where xxx is the semaphore id identified in the previous step.

4. Enter the following command to show the shared memory:

ipcs -m

5. Enter the following command to kill the shared memory:

ipcrm -m xxx

Where xxx is the shared memory id identified in the previous step.

HOW TO SETUP A PRINTER

 AIX

You can use the "smit" or "smitty" tool to set up local or remote printer access. The steps
below show how to set up remote printer access. Please refer to system documentation for
local set up.

1. Type 'smitty' at a command line prompt.

2. At the System Management screen select 'Print Spooling'.
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3. At the Print Spooling screen select 'Add a Print Queue'.

4. At the Add a Print Queue screen select 'remote'.

5. At the Type of Remote Printing screen select 'Standard Processing'.

6. At this final screen, you will be asked to enter the following information:

� Name of QUEUE to a add
� HOSTNAME of remote server
� Name of QUEUE on remote server
� TYPE of print spooler

7. Press enter and the new print queue will be added.

8. Exit smitty and verify the setup by attempting to print a small ASCII text file using the lp
command.

Please also refer to your system documentation for further information on printer setup.

How to start/stop the print server

Use "Print Spooling" in smitty, then "Manage Print Server", then select the appropriate option.

How to print a file to the local queue for a remote printer

After you have defined the local queue for the remote printer, then you could print a file by
doing:

lpr -P cordoba file.name

How to use smit to give remote access to the local printer

This section is only relevant to those people who have a laser printer locally attached to their
AIX host. Then you can do the following process to give access to other people who will
remotely use your local printer.

1. Logon as root to the workstation that has attached the local printer.

 2. Issue:

smit

 3. Select:

Print Spooling

Manage Print Server

Add Print Access for a Remote Client
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4. Perform the desired task:

List All Remote Clients with Print Access

Add Print Access for a Remote Client

Remove Print Access for a Remote Client

 5. Exit.

 HP-UX

You can set up local or remote printer access using "sam".

1. At the command line prompt, enter 'sam'.

2. Select the 'Printers and Plotter' icon.

3. Select the 'Printers and Plotter' icon again.

4. From the 'Actions' pull down, select local, remote or network based printer access.

5. Complete and/or answer the screens that appear.

Please also refer to your system documentation for further information on local, remote or
network printer setup.

 Solaris

There are 2 options:

� You can set up local or remote printer access using the "admintool" in Solaris.

1. At the command line prompt, enter 'admintool'.

2. Select 'Browse', then 'printer' from the pull down menu.

3. On the 'Admintool: Printers' pull down menu, select 'Edit', then 'add' and then one of
the following:

– 'Access to Printer' for remote printer set up, or
– 'Local Printer' for local printer setup.

4. Complete the information on the screen and select 'OK'.

Please also refer to your system documentation for further information.

� You can use the line commands below to setup a printer.

1. Ensure that the client is allowed to print on the host.

2. Do the following:
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lpsystem -t bsd server_name

lpadmin -p new_name -s hostname!printer_name

lpadmin -p new_name -T unkonwn # unless PS (PostScript)

lpadmin -p new_name -I simple # unless above is PS

3. Change directory to /etc/lp/fd

4. Do the following:

sh

for f in download dpost postio postior postprint postreverse

do

lpfilter -f $f -F $f.fd

done

5. Do the following:

accept new_name

enable new_name

 OS/2

The overall process to setup a printer in OS/2 is:

1. Setup the lprmon process for port lpt3 if you are using a remote printer that is available via
TCP/IP.

2. Setup an icon for the printer.

 Requisites

You need to install TCP/IP for OS/2; if you use DOS or WIN-OS2, then install also the DOS
Access Box diskette from TCP/IP.

You need to have at hand the 3 diskettes with the Printer Drivers for OS/2.

Setup LPRMON (line printer monitor)

LPRMON will allow you to monitor the status of a printer.

1. Open the Templates folder.

2. Drag a Program template into the desktop, select the "Program" tab and provide the fol-
lowing information:

� Name of the program:

<tcpip_path>\BIN\LPRMON.EXE

 � Parameters:
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-p lp -s cordoba.raleigh.ibm.com lpt3

Change "lpt3" to "lpt1" or "lpt2", if you have a locally attached printer you are fond of.

Change "cordoba.raleigh.ibm.com" if you want to access another host name that has
attached a laser printer.

3. Change the name from Program to LPRMON, by selecting the "General" tab and then
changing the name, to something such as "lprmon lpt3"

4. Ask the owner of the remote laser printer to get access to the printer.

Setup a printer icon for the OS/2 desktop

1. Access the printer drivers:

� Obtain the diskette 2 of the Printer Drivers for OS/2.

2. Open the Templates folder.

3. Create a printer by dragging a printer icon from the templates folder into the desktop.
Specify the following information:

a. Give it a name, such as 'Laser Printer'.

b. From the "Default printer driver" list, select IBM 4201 (and not the 4029 laser printer).

c. From the "Output Port" list, select the port, which must be the same used for
LPRMON; in this document the port is "lpt3".

d. You may need to install the printer driver.

1) Click on the button "Install a new printer driver".

2) Select IBM 4201 normal printer. Click on Install.

3) Select IBM 4029 Laser Printer 10. Click on Install.

4) Insert the appropriate diskette of the Printer Drivers (diskette 1 if using OS/2 Warp
3).

e. Click on Create.

f. If it asks if you want to create a windows printer, say Yes.

Follow the instructions. You will need diskette 1 of the Printer Drivers.

4. To make the new printer icon to be the default, click mouse button 2 on the printer icon
and select "set default" and select "Laser Printer".
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Create a REXX file to print the file (LASER.CMD)

You can create the following REXX file (LASER.CMD) which can be used from a OS/2
window:

/\ Printing a file to a remote laser printer \/

PARSE ARG input_file

'lpr -p lp -s cordoba.raleigh.ibm.com' input_file

exit

You should place this file in a directory that is listed in your PATH.

Note:  In OS/2 Warp 4 the syntax of LPR was changed. The file name is the last argument.
In OS/2 Warp 3, the file name seems to be just after LPR and before the flags.

Testing the setup from the OS/2 desktop

In order to successfully test the setup, you need to be sure that TCP/IP is up and running.

1. Open the LPRMON icon, in that way you could see the status of the printing process.

2. Open a folder where you have a text file.

3. Drag the icon of the text file and drop it on the 'Happy Printer' icon.

4. Select Printer Specific.

5. Observe the LPRMON, and you should see how the job is placed in the queue (spooling),
and then how it is printed and then how the queue becomes empty again.

6. Pick up the output from the printer.

 Windows

To install a printer that is connected via a NETBIOS LAN, do the following:

1. Exit all applications.
2. Get the diskette or CD-ROM that has the printer drivers or if your company has these

printer drivers in the LAN, then you can use "net use" to setup this LAN drive.
3. Select Start -> Settings -> Printers
4. Select the Add Printer icon. You see the Add Printer Wizard

Make sure the option Network Printer˜ is selected
5. Select Next and then type the Network Path for the printer in the Printer command line.
6. Select Next and select Have disk. You see the Install from Disk dialog box. Insert the

diskette, CD-ROM or LAN drive.
7. Select OK and select the appropriate Printer in the list of printers.
8. Select OK and then select Finish. The files are copied into your machine.
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9. If prompted, select Yes or No to indicate whether you want to print a test page.
10. If you printed a test page, you are asked if the page printed correctly. Select Yes or No.
11. You should see the Printers folder with the new printers added.
12. Select the printer you just installed.
13. Select File -> Properties. You see the printer driver's notebook.
14. Display each tab, making the appropriate changes as you go.
15. Select OK to close the notebook.

USING FSCK TO CHECK FOR THE FILE SYSTEM CONSISTENCY

In some cases in which there are problems in creating files in a file system, there is a possi-
bility that something is not right with the file system, even though there are no explicit mes-
sages about it.

You can use the command "fsck" (file system check) to check for the file system consistency
and interactively repair the file system if needed.

HOW TO CHECK THE SWAP SPACE

You can use the following commands to find out the swap space in your machine:

AIX lsps -a
HP-UX swapinfo
Solaris  swap -s
Windows NT  Select Task Manager from Start menu, then select the Performance tab.
OS/2 Warp See the CONFIG.SYS in the statement SWAPPATH.

Note:  A general recommendation is to have in swap space 2 times the amount of real
memory.

MISCELLANEOUS TOPICS, BY PLATFORM

 AIX
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How to defragment a filesystem in AIX

Through AIX smit or smitty, you can defragment a filesystem. Some steps to point out:

1. Backup the filesystem.

2. fuser -k -v LOGICAL DEVICE (e.g. /usr)

3. umount LOGICAL DEVICE

4. fsck the filesystem to fix errors.

5. mount LOGICAL DEVICE

6. Use smitty dejfs  or defragfs fileSystem .

7. You can also invoke smitty and go through the following steps:

smitty

 System Storage Management ( Physical and Logical Storage )

 File Systems

Add / Change / Show / Delete File Systems

Journaled File Systems

Defragment a Journaled File System

8. Select the file system you wish to defragment.

9. Do not interrupt the process.

10. Exit smitty when completed.

 HP-UX

Transitional links for HP-UX 10 to look like an HP-UX 9 system

In HP-UX 10, many commands were moved from their previous location in HP-UX 9, such as
mount: in HP-UX 9 was in /etc/mount, now in HP-UX 10 is in /usr/sbin/mount. By default,
HP-UX 10 installs with a compatibility package that contains the "transitional" links that allow
the shell scripts and programs that used the HP-UX 9 locations to work fine under HP-UX 10.

The following commands allow you to set and unset these transitional links. You have to login
as root in order to execute the install and removal commands.

� To install the transitional links:

/opt/upgrade/bin/tlinstall

� To list the transitional links:

/opt/upgrade/bin/tllist

� To remove the transitional links:
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/opt/upgrade/bin/tlremove

Note:  We strongly recommend NOT to remove the transitional links, because many important
utilities from HP-UX, such as the rebuilding of the kernel use them. That is, if you do not have
these transitional links, then you cannot rebuild the kernel! Furthermore, other applications,
such as Informix, require them in order to install the product.

 Solaris

How to fix problems with system files such as /etc/vfstab

If this file is corrupted, such as wrong parameters were used, then the system could hang
when trying to mount or to perform fsck.

To solve this problem, boot from the Solaris Operating System install disk. When the GUI is
shown, mount the /etc file system; you must use the device name, such as:

mount /dev/dsk/cðt1dðsð /mnt

Then you can correct the invalid entry.
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APPENDIX A. COPYRIGHTS, TRADEMARKS AND SERVICE
MARKS

The following terms used in this technical report, are trademarks or service marks of the indi-
cated companies:

+---------------------+-------------------------------------------+

| TRADEMARK, | COMPANY |

| REGISTERED | |

| TRADEMARK OR | |

| SERVICE MARK | |

+---------------------+-------------------------------------------+

| HP, HP-UX | Hewlett-Packard Company |

+---------------------+-------------------------------------------+

| IBM, AIX, | IBM Corporation |

| OS/2, OS/2 Warp, | |

| CMVC, TeamConnection| |

| VisualAge | |

| DB2, | |

| Universal Database | |

+---------------------+-------------------------------------------+

| Info-ZIP | Info-ZIP Group |

+---------------------+-------------------------------------------+

| Intel | Intel Corporation |

+---------------------+-------------------------------------------+

| Microsoft, Windows, | Microsoft Corporation |

| Windows 95, | |

| Windows NT | |

+---------------------+-------------------------------------------+

| Partition Magic | PowerQuest Corp. |

+---------------------+-------------------------------------------+

| Sun, Solaris | Sun Microsystems Inc. |

+---------------------+-------------------------------------------+

| Unix | X/Open Co. Ltd. |

+---------------------+-------------------------------------------+

| Yahoo | Yahoo! Inc. |

+---------------------+-------------------------------------------+
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